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2 Executive summary
The main software facilities to be provided in the KOM2002 projects are multi-lingual
forums and ask-the-expert areas, groupware for content development, natural-language
question-answering service and subject tree service. All these services are now running,
albeit not in all respects yet with full functionality.

The software can be accessed at     http://web4health.info/   . We do not, however, attempt to
get external users yet, and all the pages are marked with robots exclusion tags to stop
web crawlers (like Google, Alta Vista, etc.) to index them.

3 Main Website
The main website has been running for several months at      http://web4health.info/   . At
present it contains only information in English and Swedish. The main entry page looks
like this in English at present:

(The layout of this page will be revised before production usage starts.)
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4 Multi-Lingual Forums
The multi-lingual forum service provides forums, in which each message can be
provided in multiple languages. Each user provides a list of preferred languages. If a
message is available in more than one language, the version in the preferred language
for each user is shown to this user. Messages and translations of them can also be
revised, and normally the latest version is shown.

As an example, below is shown a message which is available in two languages, English
and Swedish:

The picture shows the English version, but by clicking on the link     Swedish    , a user can
view the Swedish-language version of this message. By clicking on Translate or modify
message, a user can enter or correct a translation of a message to a new or existing
language.

5 Ask-The-Expert Areas
The ask-the-expert software is running, except that tools for anonymous user
registration are not working yet. Here is an example of a question with an expert
answer:
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I have an important question.

How do you know if you have bulimia?

Almost everyone I know complain that I am too thin and ought to eat more, even
my own parents.

But I do not feel thin, rather the reverse. If I eat much one day, I have to exercise
like mad, or I get a lot of anxiety and have to eat less the next day.

It sounds as if you have an eating disorder. Please tell me how tall you are, and
what your weight is.

My weight is 55 kilo, and I am 174 cm tall.

That is a little too low. The normal weight for that height is between 60 and 75 kilo.
It is important that you do not reduce your weight even more.

6 Content Production System
The content-production system is running, see attachment A and B to this deliverable
for more details.
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7 Natural-Language Question-Answering
System

The top half of the picture on page 3 above gives access to the natural-language
question-answering system. The lower half contains the subject tree. At present most of
the content we have available is on eating disorders, since several partners had
information in this area ready before the project started. If you write for example the
question “How do I stop eating too much?” in the question area above and push the
Submit question button, you will get the following answer:

In this answer, item 3 and 6 contains reasonable responses to the question. The
classification work is not yet ready, when the classification work is ready, we expect
much better answers. Only about one third of the English FAQs and two thirds of the
Swedish FAQs have yet been classified. With the same question as above, the Swedish,
more fully classified data base, returned good answers to the question as answer no 1, 3
and 4 in a list of 4 matching answers found.

8 Subject Tree
The subject tree at present covers in English the current text content, which is mainly
information about eating disorders at this time.

Below is one example of one of the subject tree pages in the present data base:
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1 Executive Summary
The KOM2002 Groupware is a software system to assist a group of experts in different
countries to develop multi-lingual informational FAQs (answers to Frequently Asked
Questions). Functions of this software are:

• Storage of a large set of informational FAQs.

• Each informational FAQ can have a number of attributes, selected freely for
each user group.

• Each informational FAQ can be provided in multiple languages.

• A forum discussion can be associated with each informational FAQ.

• Experts can easily modify the informational FAQs.

• To avoid problems if two experts are simultaneously updating the same FAQ,
warnings are provided when a second experts tries to edit a FAQ in a certain
language, which another expert started editing within the last 24 hours.

• Experts get regular e-mail notifications, informing them of what happens in the
groupware, such as new discussion items, new FAQs, new translations, etc.

This document is a user instruction for using KOM2002 with the special document
format to be used in the KOM2002 EU project for producing medical informational
FAQs. This document is not a general instruction for using the groupware for other sets
of FAQs, and it is not a managerial instruction for setting up and managing a data base
using KOM2002.

2 Account
To use KOM2002, you need an account. You get an account by connecting to
http://cmc.dsv.su.se/eu/kom/  . You will then see the following page:
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Push the Register button. You will then get to the following page:

Type your name,
for example
Mary Middleton

Choose a login id,
for example marym

How often do you
want to be reminded
when there is news for
you in KOM. Once a
day is recommended.

Not important
or required

Push the Submit button

Language codes:
de = German
en = English
el = Greek
it = Italian
nl = Dutch
sv = Swedish

After you have registered, write an e-mail to cmc-comment@dsv.su.se and ask us to
give you privileges as an expert in our project. We will then admit you to the internal
pages for our project.

3 Entering as a Registered Expert
Once you have been admitted as a registered expert, go again to the login page at
http://cmc.dsv.su.se/eu/kom/   and log in with the shortname and password you registered
in the registration page.

When you log in, you will either get to the News or the All forums pages:
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4 Important Pages

4.1 The News Page
You click on The News command in the top left corner of the screen to go to the News
page. It looks something like this:

List of forums, in which you
have new, unseen messages. Each FAQ
has its own forum.

The special forum
with the name
“FAQ production”

List of modified
FAQs in yellow
colour.

List of new
FAQs in blue
colour.

Discussion items on the “What
is my ideal weight” FAQ.

This page uses the following different colours on the new items as follows:

Colour Usage

Blue Ordinary news like new comments in forums

Green You have become a member of a new forum

Red Moderated entries, which the moderator should check for acceptance

Yellow text Not so important changes or translations to existing entries.
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4.2 The Private Page
You go to the Private page by clicking on Private in the top of the screen. It looks
something like this:

Here is a list of
forums, where you
are organizer.

Here is a list of
forums, where you
are a member.

The number in brackets after
the forum name is the number
of contributions in this forum.
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4.3 The All Forums Page
The All forums command, in the middle of the top row, will take you to the All
Forums page. From this page, you can directly and indirectly find all forums, which are
accessible to you. Also forums, in which you are not a member, can be found from this
page.

This page contains a list of the
main forum categories.

Open for Forums
are forums, open
for everyone.

Closed for Forums are
forums open only for
some users.
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4.4 The FAQ Production Page
You can go to the FAQ production category page either directly, by using its web
address,     http://cmc.dsv.su.se/eu/kom/faqprod1;login   , or indirectly from other pages,
which have links to it.

The FAQ production page can look something like this:

The red flags indicate that you have some unseen information on this page.

Important commands in this page are:

Here you can search for a particular FAQ, using a word in
its title or body as search criterion. If this command is not
visible, use the  command. You can also

search for a particular FAQ using the search facility at
http://web4health.info/en/answers/  , but that search facility
only works for FAQs which have been classified into the
FAQ system.

Use this command if the  is not

visible.

Command to add a completely new FAQ.
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4.5 Page for Viewing a Single FAQ
If you click on the name of a single FAQ, you go to the page for this single FAQ. Here
is an example of how the top of this page can look like:

Title of the FAQ. Choose the title
carefully to help people decide if this
is the answer they are looking for.

Short name of the FAQ. This name
should never be changed after an
answer has first been created. Choose
the name as specified in the FAQ
naming guide.

The main text of the FAQ.

The source and author of the FAQ.
EU requires that all pages have some
source indication.

Click the (i) to get
more information.

The most important command above is:

This command is used if you want to modify any of the
attributes of this FAQ, or if you want to enter a translation
into another language.
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The bottom of a page showing a single FAQ looks like this:

This FAQ is available in Swedish and
English. You are just now looking at
an English version. (o o o) indicates
that there are three Swedish versions,
clicking on the last o will show the
latest of them. Click on a language
name to see the latest version in that
language.

Area for writing a comment
(discussion item) for the other project
partners on this FAQ. Not shown to
users, only to project partners.

List of comments on this page (only for
project partners) written by project
partners. There is a red flag on comments
you have not yet read.

Export area for exporting this answer to
the user data base.

4.6 Discussing an FAQ
If you want to make a comment on an FAQ, you can do it as follows:

1. Go to the web page    http://cmc.dsv.su.se/eu/kom/faqprod1;login   .1

2. Locate the FAQ to discuss in the groupware showing the FAQ. Use, for example the

 Word:               Search to locate the FAQ.

 If the command above is not visible, click on  Index this forum and wait

a minute until  Word:               Search appears.

3. Below the text of the FAQ there may be an area which looks like this:

To Discussions:

641. Addictive excersise, Jacob Palme, Wed 13 Nov 03:13 2002

This area lists already existing comments on this FAQ.
4. If you want to comment on an excisting discussing item, click on its name above

(Addictive excersise in the example above), and then click on Reply to all.
5. If you want start a new discussion thread on this FAQ, Scroll to the bottom of the

window, where you will find a Write message area to write a new comment on this
FAQ.

                                                
1 To easily get to pages you often need to get to, you can make bookmarks for them in
your web browser. This is explained in chapter 8 on page 21.



 Psychology Advice Network Page 11

Attachment A to REPORT D 5.1 version 1.0 Last update: 14 Dec 2002

5 Creating a New FAQ

5.1 Use of Dreamweaver or Direct Entry of HTML Code?
This is not an either/or, you might choose to learn to use both methods. But then the
issue is which to learn first.

Advantage of using
Dreamweaver

Advantage of writing direct code

Ease to learn You have to learn Dreamweaver. You need not learn Dreamweaver, but
will have to learn some HTML.

Editing You can easily use more advanced
HTML facilities like pictures, tables,
enumerations.

You may have to ask someone else for
help when your answer needs such
advanced formatting.

See result 1 You can see the layout of the future
text while you edit the HTML using
Dreamweaver.

You have to submit a change and
export it to the web site before seeing
how it looks like.

See result 2 If you submit Dreamweaver text to
KTH for batch processing, it may
take a week or two before it gets into
the test/demo data base.

You can immediately test how your
changed text will work when viewed by
users, and when searched for using the
FAQ system.

For an example of an FAQ with tables and pictures, see
http://web4health.info/en/answers/ed-psy-versus-normal.htm     

Another example of an FAQ with tables and some coloured text, too, see

http://web4health.info/en/answers/ed-dia-classification.htm    

For an example of an FAQ with enumerations, see
http://web4health.info/en/answers/ed-causes-addictive.htm     

5.2 Using Dreamweaver
1.  Use the File->New from Template... command in Dreamweaver to open a new

FAQ file. See [D 5.1 B] for more information.

2. Save the file with a suitable name, see [D 5.1C] on naming of FAQs.

3. Edit the text with Dreamweaver.

4. Either send the text to KTH (suitable if you have a large number of FAQs to enter at
the same time) or go to the FAQ production page in KOM (see page 8), and create
the new FAQ using the  command. Paste the content (hold the

shift key down when copying from Dreamweaver) and Submit the new FAQ.

5.3 Using direct entry of HTML Code
1. Go to http://cmc.dsv.su.se/eu/kom/faqprod1;login.

2. Use the command  to start writing a new FAQ.

3. Fill in your HTML-formatted answer in the textbox for the body.
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5.4 HTML to use
If you choose choice 5.3, you need knowledge of some HTML commands. Most of
them are simple, for the more complex examples at the end of this chapter, you may
need to use Dreamweaver or get help from someone who knows more about HTML.

5.4.1 Special Character Encodings

Note: KTH plans to modify our software so that you can use the ordinary characters in
input to our program, and we will convert them to the encoding described below. You
may thus not very often have to see these ugly encodings.

A few characters must be replaced with special encodings in HTML. The most common
of them are:

Character Encoding Example as seen by
user

Example as coded in
HTML

" <br> "Something Fishy" <br>Something
Fishy<br>

< &lt; If your age is < 65
years

If your age is &lt; 65
years

> &gt; If your age is > 15 If your age is &gt; 15

& &amp; Johnson & Co Johnson &amp; Co

ü Ü &uuml; &Uuml; Übersetzung &Uuml;zetsung

å Å &aring; &Aring; Åkerblom &Aring;kerblom

ä Ä &auml; &Auml; Länder L&auml;nder

ö Ö &ouml; &Ouml Veröffentlichungen Ver&ouml;ffentlichunge
n

é, É &eacute; &Eacute; Actualité Actualit&eacute;

A larger table of these special encodings can be found at
http://www.ramsch.org/martin/uni/fmi-hp/iso8859-1.html   .
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5.4.2 Ordinary Plain Text with no Special Formatting

Text looks like this to users:

The HTML you write looks like this:

Parents can help children achieve healthy hunger and feelings of satisfaction by

encouraging them to respect their own body signals. They should not impose upon them their

own opinions concerning when eating should take place. The children themselves, of course,

have to feel whether they are hungry or satisfied. Parents should avoid giving children

food as a consolation or reward. The child's own hunger signals must be the basis of a

decision. Food should not be associated with anything other than physical hunger. Parents

should make sure that there is always wholesome food at home and try to avoid having

tempting junk food within reach. Children may think that junk food is tastier and chose to

satisfy their hunger with it. By so doing, they deprive their growing bodies of the

nutrition they urgently need.

<p>

It is difficult for all parents to satisfy children's needs, especially if they themselves

are emotionally disturbed or pre-occupied with their own problems. They can then find it

extra hard to interpret a child's expression of its needs.

That is, the only special coding you will have to think of is to put a "<p>" between
paragraphs.
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5.4.3 Adding a Link to Another of our FAQs into your FAQ

Text looks like this to users:

The HTML you write looks like this:

In the Question input area:

Is it neglected children who get eating disorders?

In the Body Input area:

Note: Colour in the HTML examples are just for readability, you need not use these colours.

Investigations of the childhood of people with eating disorders does not indicate that

they have been seriously neglected. Ordinary terms like "lack of love" do not help us to

understand their problems. Those details which can be found are often very subtle.

<p>

The determining factor is whether the reaction to the child's needs was suitable or was

only what the parents wrongly thought was the case. Something has gone wrong in those

processes of experience and behaviour which surrounded the handling of food and other

bodily needs. Initial faulty and confusing experiences have interfered with their ability

to recognize hunger and satisfaction and to separate hunger (the desire to eat) from other

unpleasant signals which did not have anything to do with lack of food, and from emotional

stress caused by many different conflicts and problems.

<p>

<a class=mini href="ed-child-raise-infant.htm">

More about child upbringing and how to prevent eating disorders.</a>

Where “ed-child-reaise-infant.htm” is the identifier of the other FAQ you want to refer
to, and “More about child upbringing and how to prevent eating disorders” is the text
which the user clicks on to get to this other FAQ.
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If you want to put more than one such reference to another FAQ at the bottom, write
like this example:

<a class=mini href="ed-child.htm">

More about child upbringing and how to prevent eating disorders.</a>

<br>

<a class=mini href="ed-treat-child.htm">

Is slimming needed for fat children?</a>

If you want a reference to a an external web site, you have to include the full web
address of the site. Example:

<a class=mini href="http://www.something-fishy.org/isf/genetics.php">

More about genetic predispositions for eating disorders.</a>

5.4.4 Adding a Picture in your FAQ

Text looks like this to users:

The HTML you write looks like this:

If you want to include a picture in a page, write like follows for a link to a picture with
the filename salad-sauce.jpg for the picture file:

<p>Sugar raises the amount of sugar in your blood. Your body then produces insulin in

order to reduce the amount of sugar. This may cause you to feel low, and want to take

another dose of sugar. If you have this problem, switch to food which is taken up slower

by the body.

 <p>

<img src="/images/salad-sauce.jpg" width=55 height=113 align=left vspace=5 hspace=5>

Unfortunately, a lot of foods contain unnecessary sugar. For example, bread and salad

sauces often contain sugar which need not be there. Most candies also contain sugar. And

bananas consist mostly of sugar. It is possible to make good salad sauces, bread and other

food without using sugar.

You must also send the picture to KTH for inclusion in our web site. The above
example is for a language-independent picture, as for example on the page
http://web4health.info/en/answers/life-food-sugar.htm    . “align=left” causes text to
flow around the picture as on page     http://web4health.info/en/answers/life-food-   
sugar.htm     . If you exclude “align=left” and have <p> before and after the picture, then
the picture will be placed between paragraphs.

If you need to include a reference to a language-dependent picture (picture with text in
the picture, as in     http://web4health.info/en/answers/ed-psy-versus-normal.htm     ), then
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instead of src="/images/salad-sauce.jpg" write src="images/picture-
file.gif" where picture-file-gif is the name of the file with the language-
dependent picture.

5.4.5 Bulleted Lists

Text looks like this to users:

The HTML behind this might be:

<ul>

  <li>Alcoholism and drug disorders

  <li>Eating disorders

  <li>Compulsive sex dependence>

  <li>Compulsive gambling

  <li>Self-injury and anorexia nervosa (even body injury can stimulate the

      reward centre in order to protect the body from pain).

</ul>

5.4.6 Numbered Lists

Numbered lists are often used in the “sources” field.

Text looks like this to users:
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The HTML behind this might be:

<ol>

<ol>Fabio Piccini, doctor and Jungian psychotherapist, in charge of

<br>the Centre for Eating Disorders Therapy<br> at <br>Malatesta

Novello<br> nursing home in Cesena. Works privately in Rimini and Chiavari.

E-mail: <a href="mailto:fabio.piccini@iol.it">fabio.piccini@iol.it</a>

<ol>Daniela Bavestrello, psychologist and psychotherapist. Professor

in Group dynamics at Bologna university. Responsible for clinical psychology

and psychotherapy at <br>Malatesta Novello<br> nursing home.

She works privately in Rimini and Chiavar. She writes for

<br>Donna Moderna<br> and <br>Starbene<br> magazines.<br>

E-post: <a href="mailto:daniela.bavestrello@iol.it">daniela.bavestrello@iol.it</a>

</ol>

<ol>

<ol>Fabio Piccini, doctor and Jungian psychotherapist, in charge of the

<br>Centre for Eating Disorders Therapy<br> at <br>Malatesta Novello<br>

nursing home in Cesena. Works privately in Rimini and Chiavari. E-mail:

<a href="mailto:fabio.piccini@iol.it">fabio.piccini@iol.it</a>

<ol>Daniela Bavestrello, psychologist and psychotherapist with psychodynamic

training. Contract professor of Group Dynamics in the University

of Bologna. Is jointly responsible for the Clinical Psychology and Psychotherapy

Services at <br>Malatesta Novello<br> nursing home in Cesena. She

works privately in Rimini and Chiavari. Writes for "Donna Moderna"

and "Starbene" magazines.<br>

E-mail: <a href="mailto:daniela.bavestrello@iol.it">daniela.bavestrello@iol.it</a>

</ol>

5.4.7 Link List Pages

Link list pages are more difficult to produce without Dreaweaver or help from an
HTML expert. They are even somewhat tricky to produce with Dreamweaver.

Text looks like this to users:

The HTML behind this page is rather complex. It looks like this:

<table width="100%" border="0" cellspacing="0" cellpadding="9">

<tr>

<td class=body width="50%" valign="top">   

<p><b><a href="/FAQ-entries/ed-causes-links.htm">

Causes

&nbsp;<img src="/images/links-big.gif" width="9" height="12" border="0"

align=baseline></a></b><br>

<a href="/FAQ-entries/ed-child-links.htm"><font size="2">

Child care

</font></a><font size="2"><img src="/images/small-ball.gif" width="6" height="6">
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<a href="/FAQ-entries/ed-causes-slim-ideal.htm">

Slim ideals

</a>   

<img src="/images/small-ball.gif" width="6" height="6"> <a href="/FAQ-entries/ed-causes-

culture.htm">

Cultural causes

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/life-food-fast.htm">

Fast food

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-prevent.htm">

Preventing eating disorders

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-causes-addictive.htm">

Food addiction

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-dia-sexual-abuse.htm">

Sexual abuse

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-psy-self-esteem.html">

Lack of self-esteem

</a>

...

</font></p>

</td>

<td width="50%" valign="top">

<p><b><a href="/FAQ-entries/ed-treat-links.htm">

Diagnosis and Treatment

<img src="/images/links-big.gif" width="9" height="12" border="0" align=baseline><br>

</a></b><a href="/FAQ-entries/ed-treat-drugs.htm"><font size="2">

Drugs

</font></a><font size="2"><img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-plastic-op.htm">

Surgery

</a> <img src="/images/small-ball.gif" width="6" height="6">   

<a href="/FAQ-entries/ed-treat-psy-behave-change.htm">

Step by step

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-general.htm">

Plan for getting well

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-self-monitoring.htm">

Self-monitoring, diaries

</a><a href="/FAQ-entries/ed-treat-general.htm">l</a>

<img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-self-help.html">

Self-help

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-self-feeding.htm">

 Self-feeding

</a><img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-psychotherapy.htm">

Psychotherapy

</a> <img src="/images/links-small.gif" width="6" height="7">   

<img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-other-exercise-general.htm">

Exercise

</a><img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-dia-weight-ideal.htm">Your
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ideal weight</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-change-life.htm">

Changing your life style

</a>

<img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-behavior.htm">

Changing

your eating habits

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-links.htm">

Family and friends

</a> <img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-do-instead.htm">

Do something else instead of eating

</a>

<img src="/images/small-ball.gif" width="6" height="6">

<a href="/FAQ-entries/ed-treat-get-help.htm">

Where can I get help?

</a></font> ...

</td>

</tr>

</table>

6 Modifying an FAQ
To modify an already entered FAQ, or to translate it to another language, go to the page
for viewing a single FAQ, and click on the  Translate or modify  command.

You will then get to a new version of the page, which has a modification area at the
bottom. The top of this modification area looks like this:

First select the language in which you
are entering new or changed text.

Then select a group,
which should agree with
the beginning of the short
name.

If you want to modify the
text of the body of the
FAQ, move down to the
body area.

Never modify the short name
(identifier) of the FAQ.

If you only want to make small changes in the wording, you can edit the HTML text in
the body text box. For example, select the word serious as below:
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and type a replacement text, such as such as ”sincere”:

When you are ready, scroll down to the bottom of the page, and push the  Submit 
button.

If you want to make larger changes, click in the text box, whose content is to be
changed, for example the “Body” text box, and give the command  Select all  to your
web browser. Then give the command  Copy  to your web browser, move to the
Dreamweaver program, and open a new or existing FAQ based on the template for our
project (see |D 5.1 B]).

Then, in Dreamweaver, move to the Body area, click anywhere inside it, click on
 mm.editable  at the bottom of the main window, and give the  Paste  command to
Dreamweaver, holding the  Shift  button down while pasting.

Then make the modifications in Dreamweaver, click  mm.editable  again, give the   Copy 
command to Dreamweaver, holding the  Shift  button down while copying. Then move
to your web browser, give the   Paste  command to your web browser, move down to
the bottom of the page and push the   Submit  button.

7 Internal Repository of Documents
Note: This chapter describes how to add files, such as Word documents or Acrobat
documents. It does not describe how to add FAQs.

There is in the groupware an area for interntal storage of documents. You can find this
area at the webb address:     http://cmc.dsv.su.se/eu/kom/kom2002-documents;login    1

                                                
1 To easily get to pages you often need to get to, you can make bookmarks for them in
your web browser. This is explained in chapter 8 on page 21.
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7.1 To Find a Document
1. Go to     http://cmc.dsv.su.se/eu/kom/kom2002-documents;login   
2. (You will be asked to log in if you are not already logged in.)
3. Click on the name of the document you want to find.
4. After the word Attachment  (in red colour) is a link to download the document.
5. If there is more than one Attachment  with the same name, the last one is the latest

version.

7.2 Finding an Earlier Version of a Revised Document
If you want to download an earlier, not the latest version, perform step 1-3 in section
7.1. You may also see the text

Language: English( o o o o)

Each    o    represents a previous version. The last    o    is the latest version.

You might also see several entries, the entry lowest down on the page is the latest.

If there are more than one  Attachment  with the same name, they represent different
older and newer versions of this attachment.

7.3 Adding a New Document
1. Go to      http://cmc.dsv.su.se/eu/kom/kom2002-documents;login   
2. (You will be asked to log in if you are not already logged in.)
3. Scroll down to the bottom of the screen.
4. Write the title of the document in the Subject line.
5. Write an abstract of the document in the large text box.
6. Click on the  Browse...  button.
7. Locate the file you want to upload.
8. Note: If you want to attach more than one attachment, click on  Preview/Save 

between each attachment. Each  Preview/Save  may take some time.
9. Click on the  Submit  button.
10. Wait... submission of a large document may take some time.

7.4 Adding a Revised Version of an Existing Document
1. Go to      http://cmc.dsv.su.se/eu/kom/kom2002-documents;login   
2. (You will be asked to log in if you are not already logged in.)
3. Click on the name of the document you want to revise.
4. Click on the  Translate or modify message  command.
5. Continue from step 4 in section 7.3.
Note: If you are told that you are not allowed to perform  the
 Translate or modify message  command, then instead use the  Reply to all  command.

8 Making Bookmarks in Your Web Browser
If you often need to go to a particular web page, you can make a bookmark to it in your
web browser. Pages, which you may want to bookmark for our project are:

1. The forum and chat system,    http://cmc.dsv.su.se/eu/kom/   

2. The project-internal area,     http://cmc.dsv.su.se/eu/kom/faqs/;login   
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3. The FAQ production area,     http://cmc.dsv.su.se/eu/kom/faqprod1;login   

4. The area for storage of internal documents,
http://cmc.dsv.su.se/eu/kom/kom2002-documents;login   

5. The main static user web page,    http://web4health.info/  

How to add bookmarks for this is below explained using the Microsoft Internet
Explorer web browser version 6.0 on a Windows 98 computer.

Preparations first (done only once)

(a) Pull down the Favorites menu to Organize Favorites

(b) Click on the button  Create Folder 

(c) Type a suitable name for the new folder, such as Web4health

(d) Click on the new folder, and pull it uppwards to somewhere at the top of the list of
folders.

(e) Click on the  Close  button.

You  have now create a folder, in which to put the Web4Health bookmarks.

Adding a bookmark (repeat for each bookmark to add)

(a) Go to the page you want to bookmark.

(b) Pull down the favorites menu to Add to Favorites.

(c) Click on Web4health.

(d) Click on  Create in >> 

Repeat these steps for all pages you want to bookmark.
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9 The FAQ Production Process
Note: If you send a large set of FAQ files to Jacob Palme for entering, you can use the
Word template instead of the Dreamweaver template. For more information about the
Word template, see [D5.1 B].

Creating a new FAQ

Modifying or translating an existing FAQ

Discussing/commenting on an existing FAQ text

Locate the FAQ to modify (see
chapter 4.4 on methods to
search for existing FAQs).

Use the comment window at
the bottom of the FAQ viewing
page to write your comment.

Locate the FAQ file which you
already have or which KTH
has provided for you.

Edit the text in Dreamweaver.

Copy the text from
Dreamweaver to KOM (hold
the Shift key down while
copying from Dreamweaver).

Use the Submit and Export
commands in KOM to move
the FAQ to the public web site.

Modify the HTML code
directly in KOM.

Send a number of modified
FAQs to Jacob Palme for
entering into the data base.

KTH enters the FAQs into our
data base (KOM, FAQ system,
Subject tree).

Locate the FAQ to modify (see
chapter 4.4 on methods to
search for existing FAQs).

Use the “Translate or Modify”
command in KOM to modify
this page.

Copy the text to be modified
from KOM to Dreamweaver
(hold the Shift key down while
pasting into Dreamweaver),
see chapter 5.

Warning: Has the FAQ been
modified in KOM?

Create a new FAQ using
Dreamweaver based on our
templates.

Send a large set of FAQ files
to Jacob Palme for entering
into our data base.

KTH enters the FAQs into our
data base (KOM, FAQ system,
Subject tree).

Create a new FAQ object using
the “Create FAQ Type 1”
command in KOM.

Use the “Export” command in
KOM to copy the FAQs to the
public data base.
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2 Executive Summary
This document describes a format for producing answers to the Web4Health collection
of answers to questions in the mental health area. The format described in this
document is the format, which has been used by the Swedish partners in developing
information before the start of the Web4Health project.

This document assumes that you are using Dreamweaver MX under Windows 2000.
Some of the examples may not work exactly like shown here if you are using another
version of Dreamweaver. It might be possible to use another program for editing the
pages, but then the instruction here may not apply.

3 Installation
This is something you need do only once, so if you have problems with this, ask an
expert for help.

After installing Dreamweaver, download the file
http://cmc.dsv.su.se/KOM2002/web4health.zip    and unpack this file.

After unpacking, you will get a directory structure as shown in Appendix A on page 8.

The web4health folder will look something like this if you are using Windows 2000:

This text is

in Swedish

but will for

you be in

some other

language.

Start Dreamweaver, use the command  Site -> New Site...  and define a new site as
follows:

3.1 Site Name
When you give the command  Site -> New Site... to Dreamweaver, you will get the
following window first:
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Type "web4health" as the site name, and push the  Next>  button.

You will then get the following window:

Just push the  Next>  button again.
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3.2 Selecting the Web4Health Folder

Click on this folder symbol to select
the web4health folder you have just
unzipped.

When you click on the folder symbol in the window above, you will get into a file
selection window, where you can locate the web4health folder, which you have just
unzipped:

When this text
says “web4health”

Push this button
to select this folder
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3.3 Remote Server
When you push  Next:  you get to this window.

Just push  Next:  again, we will probably not use any of the built-in methods for
submitting files.

3.4 Advanced Settings
When you pushed  Next:  again, you got to the following window, where you click on
the  Advanced:  tab.
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Advanced tab

You then get to the following window, where you need to make two more settings:
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Click here and select the “images” folder within the “web4health”
folder which you have just unzipped. Note that this “images” is
only for language-independent pictures. If you need to use
language-dependent pictures (such as pictures with text, see for
example     http://web4health.info/en/answers/ed-psy-versus-   
normal.htm    ) then you have to put them in the separate “images”
folders within each language subfolder.

In this field, type the text  http://web4health.info/ .

4 Starting to Write
To start writing a new health informational answer, use the Dreamweaver command
File -> New from Template  and select one of the following four templates:

Template file name Description

FAQ-DW-entry-all.dwt Template for entering a page in all languages

FAQ-DW-entry-de.dwt Template for entering a page in German

FAQ-DW-entry-el.dwt Template for entering a page in Greek

FAQ-DW-entry-it.dwt Template for entering a file in Italian

FAQ-DW-entry-nl.dwt Template for entering a file in Dutch

FAQ-DW-entry-sv.dwt Template for entering a file in Swedish
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FAQ-DW-entry-en-Sweden.dwt Template for entering a file in English with
Swedish default author and source (Shown as an
example, partners can make similar modifications
to their templates to enter their default author and
source).

When you have opened a template, you will see the following window:

If the file contains the entry in more than one language, each language is separated by a
language-row. Attributes common to all languages can in such a case be placed before
the first language row. Apart from this, the order of the rows is not significant.

Important:   Immediately after opening the template, use the  File->Save As  command
and save it, in the folder “web4health/??/FAQ-entries” where “??” is the language of
the entry you are writing, giving it a name according to the specification in [D 5.1C].
This      must    be done before you specify any links or pictures in your web page, otherwise
the links will not work correctly.

Save each answer as a separate file, choosing the file name as specified in [D5.1C]
which can be found at     http://cmc.dsv.su.se/web4health/documentation/KOM2002-page-   
naming.doc   . Add “.htm” at the end of the file name when saving it. Save them in the
folder  web4health/??/FAQ-entries/ where “??” is the language of the entry you are
writing.
If you have downloaded a web page from another computer, it may not be attached to a
template. If you are attached to a template, then the template name is shown in the
upper right corner of the text window, something like this:



 Psychology Advice Network Page 10

Attachment to REPORT D5.1 version 1.0 Last update: 14 Dec 2002

If you do not see this, you have to attach to a template. How to do this is described in
section 4.1 below.

4.1 Attaching to a Template
Use the Dreamweaver command  Modify -> Templates -> Apply Template to file . You will
then get the following window:

In this window, select the Template to use, depending on which language you are
entering the page in (for example, FAQ-DW-entry-de means an FAQ in the German).

5 Notes when writing answers

5.1 Fields to Fill In
When you fill in the template, you need initially only fill in the following items:
Field name Contents Example

Question Typical question or questions
which users might ask to get to
this answer. Not too long.

Which drugs against obesity are good? Is there any good
medicine against overweight?

Title Title to be shown on top of the
answer page

Drugs for treatment of obesity

Body Full text of the answer. Xenical is a medicine which reduces the colon's ability
to absorb fat. The usual side effect is diarrhoea.

A medicine called Previa or Naltrexone, which was
originally used for heroin addiction, can also reduce the
problems of alcoholism and eating disorders. Some studies
indicate that large doses are required for this effect. The cost
is at present very high. More.

Phenylpropanolamine has been sold in USA as a
medicine for overeating. However, it is not very effective
and is believed to increase the risk of heart disease.

Medicines like Prozac, Fontex and Seroscand
(Fluoxetin) which raise the level of Serotonin can be a
useful component in the treatment of compulsive eating.

They reduce hunger initially. This effect, however,
disappears if you take them regularly for several weeks.

They normalise emotions. This effect will not show
until after several weeks.

Reductil (Sibutramine, Meridia) is a similar medicine,
where reduction of hunger is greater at the beginning of
treatment. Also here, the effect diminishes with time. A
disadvantage is that Reductil is far more expensive than
Fluoxetine.
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Sources Indicate the sources for the
information given. If you have no
other sources, put yourself as the
source. Use the numbered list
facility of HTML
(<OL><LI>...</LI>...</OL>

1. Addiction and the Eating Disorders, by Caroline
Davis, Ph.D., Psychiatric Times, February 2001.

2. Eating Disorders and Addiction, by Barton J.
Blinder, M.D., Ph.D.; Mary C. Blinder, M.D.;
and Visant A. Sanathara, Psychiatric Times,
December 1998.

3. Personality Characteristics of Females Seeking
Treatment for Obesity, Bulimia Nervosa and
Alcoholic Disorders, by G. Palme and J. Palme,
Personality and individual differences 26(1999),
Pergamon Press.

4. Eating Disorders, Obesity, Anorexia Nervosa and
the Person Within, by Hilde Bruch, 1973., Basic
Books, New York.

5. Anorexia Nervosa and Bulimia Nervosa,
Diagnosis, Treatment and the Role of Impulsivity
for Long-Term Outcome, by S- Spjöberg. 1987.
Acta Universitas Upsaliensis, Uppsala.

6. Treatment of severe Obesity, by H. Björvell,
1985. Gustav V-s forskningsinstitut, Karolinska
Institutet, Stockholm.

7. An explorative study of bulimia and other
excessive Behaviours, by C. Bergh, 1988. Thesis,
Karolinska Institutet.

Note: en-body is the body in English, de-body is the body in German, etc.

The rest of the fields can be filled in later or automatically.

5.2 Simple HTML
Avoid advanced and fancy HTML facilities, if not absolutely necessary.

5.3 Links between Answers
It is possible to include links between answers. Here is an example of an existing
answer with links in it:

Question: Why is it mostly women who develop eating disorders?

Answer: 

Over 90 % of those who develop eating disorders are young women. A
contributory cause is that young women try to be beautiful and slim by
means of a course of slimming diets and these often cause eating disorders
to begin.

Their ideal of slimness doesn't correspond with the body's natural needs
and therefore they must suppress the nutritional supply in order to achieve
it. When they have once begun to suppress their nutritional needs, an
eating disorder arises which later becomes permanent, whether or not they
have achieved their ideal. That's how a diet can be the start of and eating
disorder.

For example: Eve reads a fashion magazine containing photographs of
super slim models and think she is to fat. She tries to follow the magazine's
diet advice and lose about 15 kg in a few month. She receives lots of
compliments and is encouraged to continue. However, Eve finds that one
day she can't resist her intense hunger any longer and eats compulsively.
When she has satisfied her hunger she continues to eat to avoid the intense
anxiety which her failure to stay with the diet means. More. In her despair
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she tries to vomit to get rid of the food. Eve has got stuck in a pattern of
starving, compulsive eating and vomiting, which she is unable to break. She
is continuously terrified of going up in weight.

More about unnaturally slim ideals.

Source

In the example above, “More.”, “More about unnaturally slim ideals.” and “Source” are
links to other pages. The link “More.” is intentionally in a light grey colour, so as not to
disturb ordinary reading too much. Compare the following two text examples:

For example: Eve reads a fashion
magazine containing photographs of
super slim models and think she is to
fat. She tries to follow the magazine's
diet advice and lose about 15 kg in a
few month. She receives lots of
compliments and is encouraged to
continue. However, Eve finds that one
day she can't resist her intense hunger
any longer and eats compulsively. When
she has satisfied her hunger she
continues to eat to avoid the intense
anxiety which her failure to stay with the
diet means.     More.   In her despair she tries
to vomit to get rid of the food. Eve has
got stuck in a pattern of starving,
compulsive eating and vomiting, which
she is unable to break. She is
continuously terrified of going up in
weight.

For example: Eve reads a fashion
magazine containing photographs of
super slim models and think she is to
fat. She tries to follow the magazine's
diet advice and lose about 15 kg in a
few month. She receives lots of
compliments and is encouraged to
continue. However, Eve finds that one
day she can't resist her intense hunger
any longer and eats compulsively. When
she has satisfied her hunger she
continues to eat to avoid the intense
anxiety which her failure to stay with the
diet means. In her despair she tries to
vomit to get rid of the food. Eve has got
stuck in a pattern of starving,
compulsive eating and vomiting, which
she is unable to break. She is
continuously terrified of going up in
weight.

The example to the right above is more difficult to read, because the highlighting of the
link disturbs reading. The example to the left above is much easier to read, because the
link is smaller, shorter and in a light grey colour.

To insert links with Dreamweaver:

1. Write the word to contain the link, for example  More..

2. Select the whole word which is to contain the link, for example  More.

3. Open the window  Windows -> Properties  (unless it is already open).

Here is an editing window with a properties window at the bottom:
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Type the web address of the page you are linking to here. If you are linking to
another answer in the Web4Health set of answers, just type the file name of the
answer in this field. For example, if you want to link to the page
http://web4health.info/en/answers/ed-psy-versus-normal.htm     , you need only type
ed-psy-versus-normal.htm      in the  Link  field above.

4. Alternatively, you can push the  in

 and locate the file with the

answer you want to create a link to.

5. If you open the Dreamweaver window  Window -> CSS Styles  you will see the
following:
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Note: If   Window -> CSS Styles  does not show a list of styles as shown above, you
need to attach to a template. How to do this is described in section Attaching to a
Template on page 10.

6. Select the word with the link (by clicking in the word in Dreamweaver, and then
clicking on the <a> in the bottom bar of the main Dreamweaver window). Then

click on either or in the  CSS Styles  window. Click on
for links within the text (will be light grey), and on for links

below the text (will be blue).

5.4 Links to other Web Sites
Links to other web sites are produced in a similar way to links to other pages of our
own (as described in section 5.3 on page 11), but you have to fill in the whole absolute
URL of the linked site in the link field as in this example:

.
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5.5 Subject Trees
A special kind of pages are subject trees. These pages help users to find the right
answer by selecting categories, just as in Yahoo. Here is an example how such a page
can look like:

To produce such a page, it is easiest to start with an existing such page and modify it.
The page above can for example be found at
http://web4health.info/FAQ-entries/ed-links-1.htm

1. Download this page in HTML format,

2. open it with Dreamweaver,

3. locate the cell containing the Body in English (en-answer),

4. click in that cell,

5. click on mm.editable in the bottom bar of the main Dreamweaver window,

6. give the  Copy  command to Dreamweaver,

7. open a new answer with the  New from Template  command,

8. locate the Body you want to modify,

9. click on mm.editable again,

10. and  Paste  the text you have copied.

11. Then modify this so as to become your new subject tree page.
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The small round object between the items in the subject tree (  ) is an image which you
can find in http://web4health/images/small-ball.gif.

The (  ) symbol marks those menu items, which refer to new link pages. It is available
in two sizes, http://web4health/images/links-big.gif and http://web4health/images/links-
small.gif. The larger size is used in headings, the smaller below headings, as shown in
the figure on page 15.

6 Inserting Pictures in Answers
If your answer needs a picture (such as in the existing answers
http://web4health.info/sv/answers/ed-difference.htm and
http://web4health.info/sv/answers/food-sugar.htm) then put the picture in the folder
web4health/images for language-independent images (such as the picture in
http://web4health.info/sv/answers/food-sugar.htm) and put the picture in the folder
“web4health/xx/images” where “xx” is the language, for example “en” for English.

Insert the picture in Dreamweaver using the  Insert->Image  command which gives the
following window:

Select the file containing the image.

 Relative To:  should indicate:

,

and not
.
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7 Alternative: Word Template
An alternative Word Template is also available as
http://web4health.info/Templates/w4h-word-template.doc    or
http://web4health.info/Templates/w4h-word-template.dot  . (Only one of these two may
work for you, depending on reasons I do not know why.)

This template can be used for bulk entry of new FAQs, but may not be possible to use
for minor changes to existing FAQs.

This template looks like this:

File name health-info-form.doc

Title      

Questions      

Author      

Body      

Note 1: Only write in the table cells in the right column. Do not change anything else.

Note 2: Please save in "Rich Text Format" (RTF format) not in Word format.

7.1 Installation of this Template
http://web4health.info/Templates/w4h-word-template.doc    or
http://web4health.info/Templates/w4h-word-template.dot  . (Only one of them may
work)  and put it into a suitable templates folder On my Windows 98 computer, the
folder to use was named C:\WINDOWS\Application Data\Microsoft\Templates
but all versions of Word may not use the same folder for storing user-defined templates.

7.2 Writing a new FAQ
To write a new FAQ, proceed as follows:

(1) Start Microsoft Word.

(2) Use the Archive->New command.

(3) Click on wb4h-word-template.dot.
(4) Click on OK.

(5) Fill in the empty table cells Title, Questions, Author, Body, Sources.

(6) Use the Archive->Save As command.

(7) Locate the folder where you want to store the new text, for example
C:\web4health\en\FAQ-entries\.

(8) Important: Pull down the "File Format" menu to RTF format.

(9) Chose a suitable file name according to the principles specified in
http://web4health.info/documentation/KOM2002-page-naming.pdf.

(10) Important: The file name should not be longer than 27 characters (excluding the
".rtf" at the end).

(11) Click on the Save button.

(12) Close the file.
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7.3 Default Values
If you want default values in the Author and Sources file, you can get this by editing the
w4h-word-template.dot/.doc file. You can still change these fields if you want, this is

just so that you do not have to write the same text for every new FAQ you write.

7.4 Inserting WWW links
If you want to insert WWW links into your FAQ, then select the text to get a link, and
use the Insert->Hyperlink Word command.

If the link is to another Web4health FAQ, just type the name of the FAQ, ended with
".htm" into the "File or web site" field. If the link is to a web page outside of
Web4health, type the full web address into the "Field or web site" field.

7.5 Getting FAQs Inserted into the Data Base
If you use this procedure to produce FAQs, KTH can easily convert them to HTML
using a program called RTFtoHTML, and then further convert them to our input format.

To reduce the work load for me, do not send me single files, send me a number of files
which I can process at the same time. The method described above cannot be used to
add single new FAQs directly to the groupware, only for bulk production of many
FAQs which you send to me for processing. Each FAQ should be in a separate file, you
can send the whole folder with new FAQs to me, compressed in ZIP format.

7.6 Comparison to Using Dreamweaver
This is an alternative to Dreamweaver, you can also use Dreamweaver if you so prefer.
Dreamweaver gives you somewhat more detailed control of the text layout than you get
with Word. But if the only formatting you use is occasional bold or italic text,
occasional line and paragraph breaks, occasional numbered or bulleted lists, occasional
embedded WWW links, then the Word method should work as good  as using
Dreamweaver. Pictures should also work, if you produce the picture in bitmapped
format before inserting them into the text. Also send the  pictures as separate files to me
so that I ensure  that they get inserted correctly into the web page we are producing.

Note: If you use the procedure described above, you might not be able to use the same
procedure to modify FAQs which already are in the groupware data base. You will have
to use the groupware to modify such files, as described in the chapter “Modifying an
FAQ” in D5.1A (    http://web4health.info/documentation/KOM2002-groupware.pdf   ).
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Appendix A: Directory Structure of Web Site

web4health main directory

File name Description

web4health Main directory

index.html Home page for the whole directory, refers to the English home
page

de German subdirectory

el Greek subdirectory

en English subdirectory

images Non-language dependent images

it Italian subdirectory

nl Dutch subdirectory

sv Swedish subdirectory

Templates Templates

Language subdirectories (de, el, en, it, nl, sv)

Each of the language subdirectories has the following structure :

File name Description

FAQ-entries Folder into which you put your new answers. I have put a few
answers here as examples in English only.

index.html Home page for this language

answers Area with answers, such as http://web4health.info/en/answers/

index.html Directory page of this area, such as
http://web4health.info/en/answers/index.html

images Area with language-dependent images

after.gif

before.gif

Two language-dependent images used in the answer
http://web4health.info/answers/ed-difference.htm

w4h-title.gif Image used in the web page
http://web4health.info/en/index.html

sfaq
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File name Description

groups-list.txt List used to produce a structured listing of web pages, such as
http://salut.dsv.su.se/salut-faq-sv/faq.exe?

stoplist.txt List of common words which are allowed to occur in questions
even if they are not specified in the question template.

substitutes.doc List of common synonyms used in natural-language question-
answering, in Word format.

substitutes.txt The same list in plain text format.

The files at present have dummy English versions. They need to be translated, but this
is not the most urgent priority in our work just now.

Templates subdirectory
The Templates subdirectory contains the following files:

File name Description

faq-db-template-en.faq Template for moving a page into the FAQ system in
English

faq-db-template-sv.faq Same template in Swedish

FAQ-DW-entry-all-lang.dwt Template for entering a page in all languages

FAQ-DW-entry-de.dwt Template for entering a page in German

FAQ-DW-entry-el.dwt Template for entering a page in Greek

FAQ-DW-entry-en.dwt Template for entering a page in English

FAQ-DW-entry-en-Swedish.dwt The same template, but with defaults added suitable
for the Swedish medical partner, in order to show
how you can add your own defaults

FAQ-DW-entry-it.dwt Template for entering a file in Italian

FAQ-DW-entry-nl.dwt Template for entering a file in Dutch

FAQ-DW-entry-sv.dwt Template for entering a file in Swedish


